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WHATS NEW IN

INTERNET EXPLORER

New features in the Internet Explorer

browser

New communication tools

Integration with Windows 95

The World Wide Web is your gateway to the vast resources of the Internet news

reports free and inexpensive software audio and video from live concerts and

sporting events sounds and images from museums around the world quick

access to millions of information sources and much more connection to the

Web can convert your desktop computer into an information and communica

tion appliance that gives you access to data from other computers around the

world almost as easily as from files on your computers own hard disk

Combined with other programs supplied with Windows 95 Microsoft Internet

Explorer gives you set of applications programs and utilities that provide

almost everything you need to take advantage of the World Wide Web and other

Internet services such as electronic mail and network news In response to com

petitive pressure from Netscape and other companies Microsoft distributes

Internet Explorer at no charge
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SENDING AND

RE
Understanding how e-mail works

Using links to e-mail addresses in Internet

Explorer

Sending and receiving e-mail with Outlook

Express

Sending and receiving e-mail with Eudora

Sending and receiving mail through

America Online

Electronic mail also known as e-mail is both the simplest and most widely used

Internet service You can exchange messages with just about anybody who has

access to the Internet or to any other network with an e-mail gateway to the Internet

When the system is working properly most messages should arrive at their recip

ients computers anywhere in the world within few minutes after you send

them in practice its not uncommon for messages to be delayed because of

heavy network traffic or equipment problems between the sender and the

receiver Even so its almost always faster and less expensive to send messages

by e-mail rather than by the postal system
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The Internet Explorer suite includes mail client as part of the same Outlook

Express program that also acts as the newsreader In this chapter you can find instruc

tions for using Outlook Express Mail and information about Eudora another popular

e-mail client program that you can download through the Internet

How E-Mail Works

Like the other Internet services weve looked at e-mail is yet another client-server

system called Simple Message Transfer Protocol SMTP As Figure 13.1 shows you

use mail client program to send message to post office server an SMTP server

which identifies the recipients address and sends it to the mail server that handles

mail for that address POP3Post Office Protocol No 3server The mail server

stores the message in mailbox until the recipients client program requests it

Senders post Office Mail Recipients

Mail Server Server Mail

Client SMTP POP3 Client

FIGURE 13.1 Internet e-mail moves from the sender to the recipient through series of clients and

servers

If the sender or the recipient has an account on system that does not use SMTP

such as Novell MHS Message Handling Service e-mail network or an online service

like AOL or CompuServe theres an additional step between the post office server and

the mail server gateway that converts the address information from SMTP format

to the format used by the other system or from the other format to SMTP

All e-mail client programs perform at least five separate functions

They include method for creating new messages

They send messages to post office server

They receive messages from mail server

They display messages

They store copies of inbound and outbound messages

Many mail clients including both Outlook Express Mail and Eudora include addi

tional features and functions such as message filters and address books but every

mail program will handle these basic services
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Sending and Receiving ii

Address formats

In order to make this worldwide message exchange work properly everybody must

use consistent address format Unlike the post office where human mail sorter will

know what to do with letter that has the city on the top line of the address and the

recipients name at the bottom like this

Fall Riveç Massachusetts 01347

349 Oak Street

Elizabeth Borden

the computers that handle e-mail are unforgiving if an address is formatted incor

rectly the message wont get through

The standard format for an Internet e-mail address is

name@address.domain

The name part identifies the recipient using their e-mail account and the

address.domain part specifies the recipients mail server The domain is code that

identifies either the type of organization
that owns the mail server such as .com for

commercial businesses .edu for educational institutions or .gov for government agen

cies or the geographic location such as .ca for Canada or fr for France This is the

same domain name system used for World Wide Web addresses

So for example bugs@carrot corn might be an e-mail address for user with the

account name bugs on commercial system called carrot.com Every e-mail

address is unique theres only one computer with the address carrot.com and just

one user on that system with the account name bugs

NOTE

Client Programs

You have several options for sending and receiving Internet e-mail

Directly from Internet Explorer using e-mail links in Web pages

The Microsoft Messaging client supplied with Windows 95 and similar client

programs available for other operating systems
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The Microsoft Outlook Express Mail program supplied with Internet Explorer

third-party mail program such as Eudora by Qualcomm

Sending E-Mail from

Internet Explorer

When you click an email link in Web page Internet Explorer opens your default

e-mail client program and creates new message with the recipients address already

in the To field To change the default mail client follow these steps

From the Internet Explorer browse select the View Options command

and click the Programs tab The dialog box shown in Figure 13.2 will appear

SI

Ojtlook Epres F4es

.1ic.rosott 1.JtI8etrg

12

Vindcws Addre Book

FIGURE 13.2 Use the Programs Options dialog box to change your default mail client program
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Sending and Receiving t-Hjl iL1

Drop down the Mail menu and select the mail client you normally use

Dont be surprised to find one or more programs listed that you dont

recognize you might have installed program that includes mail client

along with the other functions that you actually use

Click the OK button to save your choice and close the dialog box

Sending and Receiving E-Mail with

Outlook Express Mail

Outlook Express
Mail is the SMTP client program that comes with Internet Explorer

Outlook Express News and Outlook Express News Mail use similarscreen layouts and

both are closely integrated with the Internet Explorer browser

Figure 13.3 shows the Outlook Express Mail Inbox window If youve already used

Outlook Express as newsreader the mail client screen will be familiar The upper

pane of the window contains list of messages in the current folder the text of the

currently selected message appears in the preview pane at the bottom of the window

To change to different folder select that folder from the Folder Bar on the left side of

the window Use the Layout dialog box View Layout to hide or display the preview

pane the Folder Bar and other optional Outlook Express features

The preview pane isnt the only place you can read message To open message

in separate window double-click the entry for that message in the message list

Newly received messages appear first in the Inbox folder but you dont have to

leave them there To create new folde use the File Folder New Folder com

mand To move the currently selected message to different folde drag the message

entry to the name of the destination folder

Configuring Outlook Express Mail

When you install the Internet Explorer suite of programs the setup routine will ask

you to specify your e-mail address the addresses of your outgoing and incoming mail

servers and the other information your mail server needs You wont be able to send

or receive mail unless you supply these addresses

You probably received piece of paper from your Internet service provider with all

of the necessary account names passwords and addresses when you set up your

account If you cant find the information you need call your service provider
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box-Outlook Express
______ ______

EII -uw jp

i.lPete Hanson Re nw conf 2l4I7 207PM
53 Member Comm internet

Explorer Security lrifonmatmn 3/18/67 10

Patrick Luk Request for page 3118/67 732

S3benjamincniheni Sam hail bobgibson 3/38/976 113

Welcome to your ore-stop source for all of your messaqirio needs

E-mail Multiple accounts

FIGURE 13.3 The Outlook Express Mail screen shows all the messages in the current folder and

previews the current message

To change the details about your account select Tools Accounts and click the

Mail tab Select the account you want to change and click the Properties button To set

up new e-mail account click the Add button

Creating Messages with Outlook Express Mail

To create new e-mail message follow these steps

Click the Compose Message button in the toolbar or select the Compose

New Message command in the menu bar The New Message editor window

shown in Figure 13 will appear

Type the e-mail address of the recipient of this message in the To field To

send the same message to more than one recipient type each name

separated by commas
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Sending and Receiving

If you have previously added the name of this recipient to your address

book click the file card icon and choose one or more names from the Select

Recipients dialog box

If you want to send courtesy copies or blind courtesy copies of this message

to other recipients type those addresses in the Cc or Bcc fields

Type brief description of this message in the Subject line

Type the text of your message in the main body of the editor window

When youre ready to send this message click the Send button on the

toolbar or select the File Send Message command If you have accounts

with more than one mail serve you will see submenu where you can

select the server you want to use for this message

Formatting Your Message

If you know that the person receiving this message is using mail reader that can

recognize HTML or Rich Text Formathng some newsreaders call this the text/enriched

MIME format you can specify typefaces and styles add color and background images

and incorporate links pictures
and horizontal lines into your message However most

of the people to whom you send messages will not be able to recognize these

FIGURE 13.4 Use the New Message editor to compose e-mail messages
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enhancements so they will receive your message with distracting HTML codes embed

ded in plain text They will receive formatted version as an attached file readable in

Web browser but its best not to use formatting unless you know what kind of news

reader the recipient uses

To set your default formatting option for all messages follow these steps

In the main Outlook Express Mail window select Tools Options

Click the Send tab

In the Mail Sending Format section choose HTML to turn on formatting or

Plain Text to turn it off

Click the OK button to save your choice and close the dialog box

To change the formatting option
for an individual message open the Format menu

in the message editor window and select either Rich Text HTML or Plain Text

Outlook Express also offers several preformatted backgrounds and graphics The

Compose New Message Using command opens submenu that lists half dozen

of these stationery formats However like other embedded graphics its best not to

use these formats unless youre sure the recipient is using an e-mail client program

that can recognize them

Attaching File to Your Message

To send program data file or any other file via e-mail you can send it as an

attachment to message Follow these steps to attach file to message

Create the message Its good idea to include some kind of short text

even if its just Heres the file promised to send you
Click the Insert File button on the toolbar or select the Insert File

Attachment command

Select the file you want to send from the file browser

If youre sending an unformatted text file you can either attach the file to the mes

sage or include the text as part of the message To transfer text from file to the body

of your message use the Insert Text from File command

Sending the Message

Sending message from Outlook Express Mail is two-step process first you must

place the message in your Outbox folder and then transmit the message to your mail

server which relays it through the Internet to the recipient You store the message in

the Outbox when you click the editors Send button If you change your mind about

sending message open the Outbox folder select the message and use the Delete

button in the toolbar or the Edit Delete command
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Sending and Receiving -Mail

Outlook Express will transfer messages from the Outbox to the server when you

check for new incoming mail To automatically connect to the mail server on regular

schedule follow these steps

Select Tools Options

Click the General tab

Make the Check for New Messages Every Minutes option active and set

the time interval in minutes

To manually connect to the server now click the Send and Retrieve button on the

toolbar or select the Tools Send and Retrieve command

Saving Copies of Outgoing Messages

You will probably want to store copies of some of the messages you send and

receive Therefore you should configure Outlook Express Mail to automatically transfer

your messages from the Outbox folder to the Sent Items folder at the same time that

it sends them to the mail server

Follow these
steps to make sure this option is active

Select Tools Options Send

Place checkmark in the box next to Save Copy of Sent Messages

If you organize your messages into
separate

folders by date topic or recipient you

should drag each message from the Sent Items folder to the folder where you want to

store it If you dont want to save copy of message just delete it from the Sent

Items folder

Receiving and Reading Messages

Outlook Express Mail can connect to the mail server and transfer new messages on

regular schedule or in response to manual command The same Check for New

Messages option described earlier in this chapter under Sending the Message con

trols connections for both sending and receiving messages

When Outlook Express Mail receives new e-mail messages from your mail server it

places them in its Inbox folder as shown in Figure 13.5 Unread messages appear in

boldface type with closed envelope icon After you read message the listing is

in normal type with an open envelope icon

Reading Messages

To read message select the description of that message The text will appear in the

preview pane of the Outlook Express window To open the message in separate
win

dow as shown in Figure 13.6 double-click the description of that message
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FIGURE 13.5 Incoming e-mail messages appear first in Outlook Express Mails Inbox folder

Welcome to Microsoft Outlook Express

ew als om Jjp_______ _______________jin __ _________ ___
Microsoft Outluok Express Team

Tuescfty July 15 19971995 AM

John Ross

Welcome to Microsoft Outlook Express

Welcome to your onestop source for all of your slessaglnq needs

E-mail Multiple accounts

Newsreading HTML editing

Address Book Directory Services

For more information

Lote breekinti news
fl- .-- -1

4-5
t.J n-

lnbox Outlook Express

FIGURE 13.6 Outlook Express Mail can display messages in separate widow
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Managing Messages

After you have read message there are several other things you can do with it

Forward copy to another e-mail address

Attach copy of the message to new message

Send reply to the originator of the message

Send reply to the originator
and all other recipients

The commands that control these options are in the Compose menu Several also

appear in the toolbar

Using Message Filters

The default location for incoming messages is the Inbox foldeç but you can set up

filters that automatically move specific messages to other folders Other filters can

automatically forward the message to another recipient send prepared reply or dis

card messages from certain senders or with certain words in their headings

To set up mail filter follow these steps

From the main Outlook Express window select Tools Inbox Assistant The

Inbox Assistant dialog box will appear

Click the Add button The Properfies dialog box shown in Figure 13.7 will appear

IIrn

FIGURE 13.7 Use the Properties dialog box to set up an automatic message filter
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Fill in one or more fields to describe the type of message you want to filter

For example you might want to automatically delete all messages you

receive from particular address or send standard reply to all messages

with particular subject line

In the Perform the Following Action section select one or more options that

describe what you want to do with the message

Move To Select the Move To option to transfer the
message from the Inbox to another folder

Copy To Select the Copy To option to leave one copy in the Inbox and place second

copy in another folder

Forward To Select the Forward To option to send the message to another e-mail address

Reply With Select the Reply With option to automatically send specified text file to the

address in the Reply To or From field of the original message

Do Not Download from the Server Select the Do Not Download from the Server option

to keep the message on the server rather than downloading it to Outlook Express Use this

option if you want to hold certain messages for later downloading For example if you are

traveling you might want to hold certain message types until you return to your own office

Delete off Server Select the Delete off Server to discard messages without transferring

them from the mail server Use this option for message types that you dont want to see

such as junk mail from advertisers or mail from people who have previously sent you

abusive mail that you dont want to read

Click the OK button to save your new filter and close the dialog box The new

filter will be visible in the Inbox Assistant dialog box as shown in Figure 13.8

FIGURE 13.8 The Inbox Assistant dialog box shows the status of all message filters
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Sending and Receiving Mail VIII

To turn on filter place checkmark in the box to the left of the description

Click the OK button to save your choices and close the dialog box

Managing E-Mail with Eudora

It wont surprise you to learn that Microsoft is not the only place you can go for an

Internet e-mail manager program One of the best alternatives is Qualcomms Eudora

Originally developed at the University of Illinois in 1988 Eudora is now used by about

ten million people

Qualcomm offers two versions of the program Eudora Light which you can obtain free

from http//www.qualcomm.com/prodtech/quest/light.html and Eudora Pro

which is sold as shrink-wrapped product from software retailers or directly from

Qualcomm Both versions are fully functional e-mail managers but the commercial ver

sion has several added features including text formalfing spell checking and support for

more than one mail server

Eudora displays each mailbox and each inbound and outbound message in sepa

rate window as shown in Figure 13.9 You can move message from one mailbox to

another by dragging and dropping or using the commands in the Transfer menu

onfiguring

Eudora requires the same kind of configuration information as other mail programs your

own e-mail address the addresses of your mail server and POP3 serveç and so forth All of

these settings are in the Options dialog box which you can reach from the Tools menu

Most of the other Eudora options control the way the program displays messages

on your screen and the details of its interaction with the mail server The most essen

tial options for sending and receiving mail are in the Getting Started Checking Mail

and Sending Mail sections of the Options dialog box

Receiving Messages with

Eudora can automatically connect to your POP server and check for new mail on

regular schedule or if you prefer only when you enter manual Check Mail com

mand The Checking Mail Options dialog box shown in Figure 13.10 includes two

options that control the way Eudora retrieves mail for you

Check for Mail Every Minutes To check for new messages automatically

type
the number of minutes you want Eudora to wait between downloads in
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FIGURE 13.9 Eudora displays messages and mailboxes in separate windows

this field Unless you expect to receive really huge volume of mail youll want

to set an interval of at least 10 or 1S minutes If you prefer to check for mail

manually set the interval to minutes

Send on Check If the Send on Check option is active Eudora will automatically

upload any messages waiting in the message queue to the mail server every time

it checks for new mail If the option is not active youll need to use the Send

Queued Messages command in the File menu to upload outbound mail

Sending Messages with

To create an e-mail message choose the New Message command in the toolbar or

the Message menu When the window shown in Figure 13.11 appears fill in the To

and Subject fields and type your message in the lower portion of the window If you
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Sending and Receiving

FIGURE 13.10 The Checking Mail options control the way Eudora downloads mail from

your
POP server

want to send file along with your message use the Attach File command in the

Message menu to specify the name and location of the file Use the Attachments cat

egory in the Options dialog box to specify the type of formatting you want to apply to

this file

When you create new message you can either send it to your mail server as soon

as its finished or place it in message queue for later transmission To change the

configuration open the Tools menu and select the Options command and then click

the Sending Mail icon The Immediate Send option is the first item in the Sending Mail

dialog box

If the Immediate Send option is active Eudora will connect to your mail server and

upload each message as soon as you click the Send button If Immediate Send is not

active you must either use the Send Queued Messages command in the File menu or

make the Send on Check option active and wait for the next time Eudora checks for

new mail
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doraLig1it ________ ___ ______ ___

Sending and Receiving Mail

through America Online

If you connect to the Internet through America Online your mail does not pass

through an SMIP server Therefore you must use the mail programs in the AOL client

program rather than Outlook Express or any other separate mail reader

The controls for handling e-mail on AOL are all in the Mail menu Select Compose
Mail to create and send messages or Read New Mail to see incoming messages

In the long run it really doesnt matter which mail client program you decide to

useonce you learn how to use any of these programs you will send and receive

your mail without thinking about the command set or the screen layout And of

course those messages are the whole point of e-mail in the first place

FIGURE 13.11 Type the details and text of your messages in the new message window
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